Article Site Builder (ASB) Installation
The most complicated and technical part of using ASB is getting ready to use it. Once you have installed and set up ASB, actually creating your web pages with ASB is easy.

We will explain the steps and options as clearly as possible. Some options depend on your web host configuration, and some are a matter of your preference. If you are still not sure you understand, you can probably find a computer geek friend/coworker/relative to help you.

Don't worry, we will explain everything so that a non-technical person can install and use ASB with confidence, and we will also include tips for "advanced" users, indicated by the ► symbol.

► Installation Overview

If you are familiar with installing and setting up scripts, these are the steps you need to follow:

1. Extract (unzip) the ASB files

2. Upload the files to your web site server

3. Configure the SQL database using the database.sql script

4. Create a directory named "output" for the ASB results

5. Set the output directory to full permissions (chmod 777)
ASB Requirements

ASB uses PHP and SQL programming to work it's magic. This means you probably can't use ASB on your home or office computer – you need to install ASB onto the server that hosts your web site. Once you are set up, you can use ASB on any computer with an internet connection and a web browser. Some popular web browsers include Internet Explorer, Firefox, Safari, and Netscape.

Server? PHP ? SQL? Hey, I'm not a computer geek!

What is a server?
Your web site host keeps your web pages and other files necessary for your site on a computer known as a server – because it "serves" the files by sending them to the computer that requests to view them in its web browser. When you log in to your web site, you are connecting to your web site's server, usually through a web page called your Control Panel (or Administration).

What is PHP?

PHP is an abbreviation for Hypertext Preprocessor. Web pages are written in hypertext, which provides their special features, such as links to other web pages. A Hypertext Preprocessor works with the web pages on your web site host computer, or server, to add enhanced capabilities, such as creating new web pages, and PHP allows ASB to work its magic. You don't need to know anything about PHP to use ASB – you just need a web site host that has PHP capability (and most of them do!)

►PHP is a server-side, cross-platform, HTML embedded scripting language that lets you create dynamic web pages. PHP-enabled web pages are treated just like regular HTML pages and you can create and edit them the same way you normally create regular HTML pages. 

(from http://www.terena.nl/library/gnrt/appendix/glossary.html )

Do you PHP?

Your web site host server must have PHP capability. If you see anything called "PHP" in your web site Control Panel or Administration Area (the first page you see when you log on to your web site host), you probably have PHP. You can also check your web host's Help, FAQ, or Support.

►If you're still not sure, create a file on your server named "phpinfo.php" 

with this copy and paste code:

<?php

phpinfo()

?>

View phpinfo.php in your browser, and if you have PHP, you will see a page with a lot of information; the details are not important – you have confirmed that your server has PHP! 

What is SQL?

SQL is a database. A database stores information (or "data") in a formal structure so it can be used efficiently. ASB uses the SQL database to store information about the articles. You don't need to know anything about SQL to use ASB – you just need a web site host that has SQL capability (and most of them do!)

Do you have SQL?

Your web site host server must have SQL capability. If you see anything called "SQL" or "mySQL" in your web site Control Panel or Administration Area (the first page you see when you log on to your web site host), you probably have SQL. You can also check your web host's Help, FAQ, or Support.

What if I don't have a Web Site Host, PHP, or SQL?

If you don't already have a web site host, you will need one to use ASB, and to make the articles and web pages you create available on the internet.

You can perform a web search for "web hosting" – like this one on Google:

http://www.google.com/search?&q=web+hosting
Just make sure the web host you have, or the new one you choose, supports PHP and SQL.

Many free web hosts (like Yahoo! GeoCities) do not provide PHP and SQL !

Here is a Google search for free web hosting including PHP and SQL:

http://www.google.com/search?q=web+hosting+%2Bfree+%2Bphp+%2Bsql
►If you want to host your web site yourself, or you insist on using ASB on your local computer, then you must have a web server, PHP and SQL installed on your own computer. You can start with the free Apache web server: http://httpd.apache.org/
Installing ASB:

ContentBuilder45.zip
ASB is distributed in a file named ContentBuilder45.zip. It is a "zipped" file, which contains all the individual files you need for ASB. You will need to "unzip" ContentBuilder45.zip. There are two ways to do this: Either your web host provides a method for the unzipping, or you will need to unzip on your own computer. We'll discuss these choices soon, but first, we need to explain how to send files through the internet to your web site host, which is also known as "uploading."

There are two ways to upload: You can use the upload feature on your web site host, or you can use FTP. Don't worry, we'll explain all this in painstaking detail.

Your web site upload interface

When you log in to your web site host, you will be on your Control Panel (sometimes also known as Administration) page. There are a lot of icons for various utilities to manage your web site. One of them is the File Manager, which will display your web site's files, and provides file management options, such as rename, delete, move, edit, and ... upload! When you first open the File Manager, you will be in the "root directory" of your website, which means the top-level folder which contains all the files and folders for your web site. The "root" is a good place to put ContentBuilder45.zip, so look at the menus at the top and the right side for a button or link named "Upload." When you click on "Upload" a Browse selector will appear. You need to choose the location on your computer where you downloaded or saved ContentBuilder45.zip, so that the name of the file (ContentBuilder45.zip) shows in the Browse field. Then you can click the Upload (or Go) button on the Upload interface to send the file to your web site host server computer.
Uploading with FTP

"FTP" is an abbreviation for File Transfer Protocol. FTP software connects your computer to your web site host server computer through the internet. Once the two computers are connected, you can upload files from your computer to the server, or download from the server to your computer. You can either use FTP software, or the Internet Explorer browser's built-in FTP function. 

► Using Internet Explorer for FTP is convenient, but it is slower than most FTP programs, and lacks other features, such as the ability to change permissions for access to files and folders.
► The Firefox browser doesn't support FTP without a client modification known as FireFTP.
FTP server name, username, and password

You will need to know your FTP server name, your username, and your password. Your FTP server name is usually the same as your domain name for your web site. For example, if your web site domain name is www.mysite.com, that is probably also your FTP server name. If this doesn't work, you may need to replace the "www" with "ftp" – ftp.mysite.com. Your FTP username and password are usually the same ones you use to log in to your web site host. If you are unable to connect to your site, look in your web host Control Panel or Administration Area for information about logging in to FTP.

Logging in to FTP with Internet Explorer

Start up the Internet Explorer browser (and make sure you are connected to the internet). 

Enter ftp://yourFtpServer (replace yourFtpServer with your actual FTP server name) in the Address bar at the top of Internet Explorer and either press the Enter key or click on the Go button. 
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If you have entered a valid FTP server name, you will see a log in panel. Enter your username and password and click on the Login button. You should see your web site's files and/or folders in the browser window. When you log in, you will be in the root directory, the top folder that contains all the files of your web site.

Warning: Changes you make in the Internet Explorer FTP browser window will change your web site's files on your web host. If you delete a file here, it will be gone!
► You can open a folder in the Internet Explorer FTP browser window by clicking on it. You can also create a new folder by selecting the New option under the File menu, then click on the Folder option. Another way to create a new web folder (using a Windows PC) is to click with the right mouse button on an empty part of the browser window where you see your web site's files. A pop-up menu will appear, choose the New option and click on the Folder option.

Uploading with Internet Explorer's built-in FTP

Find the file (or files) you want to upload on your computer. On a Windows PC, use Windows Explorer, My Computer, or Find (or Search) on your Start menu. 

You can then copy and paste, or drag and drop, the file(s) from your computer to the Internet Explorer FTP browser window. 

To copy on a Windows PC, click once on the name of the first file you want to upload (you can add additional files by holding down the Ctrl (or Control) key while clicking once on the additional files – or hold down the Shift key and click once on a file to select several files at once). Make sure the file(s) are highlighted. Then you can copy the file(s) by clicking on the Copy button in the menu bar, selecting the Copy option under the Edit menu at the top of the window, or by clicking on a highlighted file with the right mouse button and selecting Copy from the pop-up menu, or you can use a keyboard command by pressing the Ctrl key and holding it down while you also press the C key.

To paste the file(s) into the Internet Explorer FTP browser window on a Windows PC, first bring the Internet Explorer window back into view. You can click on the Paste button in the menu bar, use the Paste option under the Edit menu, or click with the right mouse button where you see the files for your web site and choose the Paste option from the pop-up menu, or you can use a keyboard command by holding down the Ctrl key while pressing the V key.

You choose which method you prefer for copy and paste (button, menu, right click, or keyboard command) – it's up to you. In fact, you can copy the file(s) one way, and paste using a different method!

To drag and drop the file(s), arrange and/or resize the Internet Explorer window and the window showing the file(s) you want to upload so that they are next to each other in your monitor screen. You must be able to see the filename you want to copy and the Internet Explorer FTP window at the same time. Then, click once on the name of the first file you want to upload. If you are only uploading one file, hold down the mouse button and move the mouse so it is now over the Internet Explorer window (this is the "drag" part). Then release the mouse button to "drop" the file onto the Internet Explorer FTP window. You may also select multiple files on a Windows PC by holding down the Ctrl key before you click once on each file, or you can hold down the Shift key and click once on a file to select several files at once. When you have selected and highlighted the files you want to upload, click on one of the highlighted files once, hold the mouse button down, drag and drop the highlighted files onto the Internet Explorer FTP window.

Checking your upload

You should see the file(s) from your computer appear in the Internet Explorer FTP window, which means now they are also on your web host server computer!

Warning: When you are finished uploading with the Internet Explorer built-in FTP, close the browser to log out of the FTP session. If you don't log out, someone else using the computer after you will have access to your web site's files!
► If you are using an Apple Macintosh computer, the procedures for copy and paste, and drag and drop, are similar. Instead of the Ctrl key, you use the Apple (Command) key. Instead of clicking on the right mouse button, you hold down the mouse button until the pop-up menu appears.

► You can also download, or send files from your web site to your computer, by reversing the direction of the copy and paste, or drag and drop, starting with your web site file(s) on Internet Explorer, and ending at your computer.

Uploading with FTP software

FTP software programs are designed to make your FTP session more convenient. They upload the file(s) faster, and provide more options than the Internet Explorer FTP.

If you don't have FTP software, you can find some with this Google search:

http://www.google.com/search?q=ftp+software
We use AceFTP, which can be downloaded for free:

http://software.visicommedia.com/en/products/aceftpfreeware/
When you start your FTP program, you will need your ftp server name, your username and your password (see the related heading above) to create a connection. When you connect, you should see the files and folders of your web site in one panel of the FTP program, and the files and folders of your computer in the other panel. Choosing files in  these two panels is a lot like using Windows Explorer or My Computer on a Windows PC. You select the location to send your upload by clicking on the folders in the panel that displays your web site's files. When you first connect, you will be in the root directory, the web folder that contains all the files and folders of your web site. Find the file(s) you want to upload in the other panel that displays your computer's files. Then, click on the button with an arrow pointing from your computer's panel to your web site's panel to send the file(s) to your web site. The file(s) should appear in the panel for your web site, indicating that you have uploaded them!

Upload ContentBuilder45.zip to your web site host

If you have not already uploaded the file ContentBuilder45.zip to the root directory of your web site host, do so now, using one of these methods (File Manager Upload, Internet Explorer FTP, or FTP Software). Now you are ready to unzip, or extract, the files for ASB from the zipped file. 

Unzipping on your web site host

Some web site hosts allow you to unzip (also called "extract") a zip file. Sometimes this is called "Archive Manager" in your web site main Control Panel. If you're not sure your web host offers this feature, you can check your web host's Help, FAQ, or Support.

Once you find the zip extractor or archive manager, click on the icon or link to activate it. You should see a way to browse and select the zip file. Since you saved the file in your web site's main root directory (web site folder), you should be able to locate ContentBuilder45.zip with a click or two. Once you see the file name, click in the check box next to it, then click on Extract.

The files and folders contained in ContentBuilder45.zip will appear on your web site in a new directory (web site folder) named "ArticleSiteBuilder." 

You can see the new "ArticleSiteBuilder" folder by opening the File Manager from your web site Control Panel. If you don't see a folder named "ArticleSiteBuilder," click on the folder with your web site name, and then you should see the "ArticleSiteBuilder" folder. You can also check this out with FTP, by logging on either with the Internet Explorer browser's built-in FTP, or connecting to your web site with an FTP program.

If you can't unzip on your web site host, you can unzip on your own computer.

Unzipping on your computer

Note: It doesn't matter where you unzip ContentBuilder45.zip on your computer. In order to use ASB, you will need to send the extracted files to your web site host. You will not be using ASB on your computer – in fact, you can delete the unzipped files when you are finished installing ASB.

You probably have the ability to unzip files already on your computer. If not, you will need to install software, and we will tell you how.

Find the file ContentBuilder45.zip where you downloaded or saved it. If you saved it on your Desktop, the file will be right there. On a Windows PC, use Windows Explorer, My Computer, or the Find (or Search) option in the Start Menu to locate the file.

Double-click on ContentBuilder45.zip to try to open the zip file, and see what happens.

Unzipping with Windows XP

If you are using Windows XP, you will see a list of the ASB files. To the left of the files, click on the option to "Extract" all of the files. A new folder named "ArticleSiteBuilder" will be created in the same location as the zip file with all the ASB files inside it.

Other ways to unzip

When you double-click on ContentBuilder45.zip, a zip file management program, such as WinZip may start. You should see a list of the ASB files. Click the button labeled "Extract" in the menu the top. If you don't see the button, click on the menu named "Actions" and select the "Extract" option. You will be prompted to choose a location on your computer. It is recommended that you choose either the Desktop, or the "root" (top level) of your hard drive, known as "C:" – you might need to click on My Computer to locate C: A new folder named "ArticleSiteBuilder," with all the ASB files inside it, will be created in the location you chose.

If your computer prompts you to choose a program to open ContentBuilder45.zip when you double-click on it, select WinZip or another program with "zip" in the name.  If nothing happens when you double-click on ContentBuilder45.zip, or if an editing program starts (Notepad, Word, etc.), you need to download and install a program for unzipping.

Download and Install WinZip

WinZip is a popular program for extracting zip files. You can download a free evaluation version of WinZip here: http://www.winzip.com/downwz.htm
Double-click the download file, winzip90.exe, to start the installation procedure. Now that you have WinZip, you can double-click on ContentBuilder45.zip to extract ASB.

Upload ASB to your web site host

If you unzipped ContentBuilder45.zip on your computer, you need to send the ASB files to your web site host. You should use either an FTP program, or the Internet Explorer browser's built-in FTP. We don't recommend using your web host's File Manager Upload, because there are so many files, and you will need to create a directory (web folder) on your web site host.

If you use the Internet Explorer FTP, copy and paste, or drag and drop, the icon for the folder named "Article SiteBuilder" that was created when you unzipped ContentBuilder45.zip.

If you use an FTP program, connect to your web site host, then locate the folder named "ArticleSiteBuilder" in the panel that shows the files and folders on your computer. Click on the folder once to highlight it.  Select the location on your web site host to send the folder, then click on the arrow pointing from your computer's panel to the web host's panel. You should see some progress information, then the folder should appear in the panel of your web host.

Setting up ASB on Your Web Site Host

You're almost done installing ASB. There are a couple more things you need to do.

Tell ASB about Your Database

ASB uses a database named SQL, which is part of your web site host. A database is a way to store information (or data) in a highly structured way so that programs, like ASB, can use the data. You don't need to know how your database works. You need to tell ASB what your SQL host is named, what the ASB database is named, and where it is.

Finding Your SQL Information

If you are not already logged in to your web site Control Panel, log in now. In the Control Panel, click on the icon named "SQL" or "mySQL." You may be prompted to enter a username and password – these are usually the same as the ones you used to log in to the Control Panel.

What is Your SQL Host Name?

When you click on the SQL or mySQL icon in your web site Control Panel, you should see something like " Host Name: hostname" – where hostname is the internet address (or URL) of the database host, for example "mysql.dig-creation.com" (sometimes the host name is followed by some numbers representing the host's IP address – or sometimes all you get is the numerical name - you can use either the hostname or the numbers). Write down the hostname.

Sometimes, 

What is Your Database Name?

You will see a list of your databases on your web site host. You may use an existing database for ASB, but to insure that you do not corrupt the data, it is best to create a database specifically for ASB.

Create a New Database for ASB

Click on the button to create (or add) a new database. Usually, the first part of the name is already entered, and it is similar to your web site domain (or internet address) name. In the text field, you may enter whatever you want for the second part of the name; we recommend that you call the new database "ASB." Write down the full name of the database, including the first part that was already filled in, and the second part that you entered. There may also be a place to enter a description for the database – you may describe the database as you wish; we recommend that you enter "Article Site Builder." Click on the button named "Create Database" (or something equivalent). If you already have a pre-existing database, you should grant the existing user access to the new database. If you don't see any information about an existing user, you need to create a database username. You will either be prompted to enter the username, or click on the button named "Add User." The first part of the username may be already entered – so complete the username with a name of your choice (for example: "spike"). You may then be prompted to enter a database password. Enter the same password that you use to log in to your web site host (Control Panel). (see warning about changing the database password below!) You may also be prompted to set the user's role, privileges, or access – you should select the "Full Access" or "DBA" (database administrator) option. If you have any problems creating a new database, consult your web host's Help, FAQ, or Support – there is often a link in the database management area to view documentation about using the database.
What is Your Database Password?

Usually, your database password is the same as the one you use to log in to your web site host (Control Panel). If ASB doesn't work using your log in password, consult your web host's Help, FAQ, or Support.
Warning: If you change the password for one database, it usually changes the passwords for all of them. Changing the password could prevent other scripts already installed on your web site from working! Do not change the password unless you are sure you know what you are doing! (But you may need to enter a password if this is the first database you are creating – just enter the password you use to log in to your web site host Control Panel).

Ok, I know the database host, username, password, and database name – now what?

You need to add this information to config.php, which is one of the files you unzipped and uploaded (or uploaded and unzipped). Go to your web site host's Control Panel and click on the File Manager icon. If you don't see the ArticleSiteBuilder directory (web site folder), find it by clicking on the folders in the File Manager. When you find it, click on it to see the files inside it. Select config.php by clicking on the filename or clicking in a checkbox next to the filename. Then choose the "edit" option, which should be in a menu above (and/or below) the files, or sometimes to the right of the files. An editing window should appear.

Editing config.php

You will see a few lines of code. We are concerned with the third, fourth, fifth, and sixth lines, which look like this:

$USER_VAR['SQL_HOST']="localhost";

$USER_VAR['SQL_USER']="your_DB_username";

$USER_VAR['SQL_PASS']="your_DB_password";

$USER_VAR['SQL_DB']="your mySQL database name";

Replace "localhost" with your database hostname (or numbers) which you wrote down earlier. Replace "your_DB_username" with your database username. Replace "your_DB_password" with your database password. Replace "your mySQL database name" with the name of your ASB database.  You must keep the quotation marks at the beginning and end!
Check your work, then click on Save.

Set the Database tables (we're having company)

Think of your database as a banquet hall that is catering an event. There are a number of tables, and each table has a unique arrangement of place settings – different tables may have varying components making up each place setting.

It's your job to build the tables in your database – ASB takes care of the rest. You even have a tool that builds the tables, you just need to give it to your database.

The tool is the ASB file named database.sql, which contains instructions telling your SQL database how to create the tables necessary for ASB. You need to open the file so you can copy the table building instructions and paste them into your database. You can open the file in your web browser, or in your web site host File Manager, since it's already in your ArticleSiteBuilder directory (web site folder) – or, if you unzipped ContentBuilder45.zip on your computer, you can open it on your computer.

Opening database.sql in your web browser
Direct your web browser to the file database.sql. The location (URL) should look something like this: http://yoursite/ArticleSiteBuilder/database.sql. Type or copy the URL location into the address bar at the top of your browser (make sure to replace yoursite with the domain name of your web site, the location you normally use to look at your site). The press the Enter key, or click on the Go button. See Copying and pasting the text from database.sql below.

Opening database.sql in your web site host File Manager

Go to your web site Control Panel and activate the File Manager by clicking on its icon or link. Locate the ArticleSiteBuilder folder, and click on it to see the files inside it. Click on the file name database.sql, or click to check the box next to it, and select the Edit option. See Copying and pasting the text from database.sql below.

Opening database.sql on your computer
On a Windows PC, click on the Start menu button (usually on the bottom left of your screen). Move your mouse to the Programs menu, and then to the Accessories menu, then click on WordPad, which is a simple text editor. In WordPad, click on the icon of the opening folder in the top menu, or click on the File menu at the top and then click on Open. Locate the ArticleSiteBuilder folder, click on it to open the folder, and double-click on database.sql to open the file.

You can also use the Search (or Find) option in the Start menu to locate the file database.sql. Double-click on it. You will probably see a box called Open With to choose a program to open the file. Click once on WORDPAD – and make sure the checkbox next to "Always use this program to open this file" is NOT checked – then click on the button labeled "OK" on the bottom.

► We do not recommend using the Notepad text editor because database.sql is formatted. You probably could use Microsoft Word, but WordPad is simpler and less-likely to introduce format changes. 

► If you are using an Apple Macintosh computer, use TextEdit or a similar text editor (but avoid SimpleText because of the formatting in database.sql).

Copying the text from database.sql
You should see the text of the file; it starts like this:

-- ArticleSiteBuilder SQL Dump
On a Windows PC, there are a few ways to copy the text. You can click on the Edit menu at the top, and click on Select All (the text will become highlighted), then click on the Edit menu again and select Copy. You can alternatively use a keyboard command by holding down the Ctrl key, then pressing the A key to select all of the text (the text will become highlighted), then hold down the Ctrl key again and press the C key to copy. While the text is highlighted, you can also copy by clicking anywhere on the text with the right mouse button (make sure it all stays highlighted), and select Copy from the pop-up menu.

The text is now placed into your computer's clipboard, so you can paste a copy of it into your database. Do not copy anything else before you set up the tables in your database.

Finding your SQL query window

Return to your web site host's Control Panel, and click on the icon named "phpMyAdmin" – if you don't have that icon, click on the one named "MySQL" or "SQL." This should take you to your database administration page. Click on the database we created earlier – the one with "ASB" in the name. (You may be prompted to log in to your database – use the database username and password we discussed earlier.) You should see a page with your ASB database name at the left and some other stuff on the right. Click on "SQL" in the menu at the top of the right side, or look for an option named "Query Window" and click on it. A window should appear with a box to enter text, and above it, you should see something like "Run SQL query/queries..."  The text box is where you want to paste the instructions you copied to your clipboard!
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If you have trouble, or your web host's database admin is unrecognizably different from our description, consult your web host's Help, FAQ, or Support. There may also be a special database Guide, Documentation, or Help link in the database administration page.

► For full documentation about the MySQL database, visit this web site:

http://dev.mysql.com/doc/mysql/en/index.html
Pasting the text from database.sql into SQL

Click with your mouse in the white text box to ensure that it is active.

On a Windows PC, there are a few ways to paste, too. You can use a keyboard command by holding down the Ctrl key, then pressing the V key. You can click on the text box with right mouse button, and select Copy from the pop-up menu. If the query is within a normal browser window, you can click on the Edit menu at the top of the browser and then select Copy from the drop-down list (sometimes the query is set in a pop-up window, so you may have to use one of the other paste methods).

If you scroll to the top of the text you pasted into the query, it should look the example above.

If nothing happens when you paste, you need to copy the instructions again, then try pasting again.

You can copy one way, and paste using a different method – the choice is up to you!

► If you are using an Apple Macintosh computer, the procedures for copy and paste are similar. Instead of the Ctrl key, you use the Apple (Command) key. Instead of clicking on the right mouse button, you hold down the mouse button until the pop-up menu appears.

Build the database tables

After you have pasted in the instructions, click on the button labeled "Submit Query" or "Go" below the text box. SQL will create five tables, which you should be able to see in your database admin panel. The five tables are named:

asb_articles

asb_cat_articlecity

asb_cat_goarticles

asb_search

asb_sourcetags

You're done! Log out of  (or Exit) the database admin panel.

Create a directory (web folder) for the ASB results

ASB sends the articles and index pages of each search to the directory you specify at the top of the ASB page. The default directory is named "output" when you start ASB. You will need to create this directory on your web site. You may use either your web site File Manager, or FTP,  to create the new directory.

Create a new directory with your web site File Manager

Log in to your web site Control Panel and click on the File Manager icon. Find the ArticleSiteBuilder folder and click on it to open it – you should see all the files for ASB, beginning with "ac_in.php," and also a folder named "images."

Your File Manager may have a place to enter the name of the new directory next to the button, so type in "output" then click on the Create Directory button. Otherwise, you need to open up the Create Directory tool. Click on the menu button named "mkdir" or "new dir" (or something like that with "dir" in the name). Type "output" in the text field that appears, then click on the button named "Create Directory" or "Go" or something like that.

Now when you look at your ArticleSiteBuilder folder, you should see the new "output" folder. If you don't see it, try clicking on the Refresh button in your web site File Manager, or try the Refresh (or Reload) button at the top of your web browser. You can also try moving the File Manage up one level to the parent directory of the ArticleSiteBuilder folder, then clicking on the ArticleSiteBuilder folder to open it again. If you still don't see the "output" folder, you probably did not create it. Try it again, or consult your web host's Help, FAQ, or Support.

Do not log out of your web site File Manager, you need to set permissions for the output folder (see Set permissions for the output folder below).

Create a new directory with FTP

(see FTP server name, username, and password and Uploading with FTP software sections above) 
Start your FTP program and log in to your web site FTP server. If you don't see the ArticleSiteBuilder folder, double-click on the other folders to find it. Double-click on the ArticleSiteBuilder folder. You should see all the ASB files and folders, starting with a folder named "images" and a file named "ac_in.php." 

Next to the panel, click on the button with an icon of a folder (when you position your mouse over the button, you may see a tip like "Create New Folder"). You may also be able to use a keyboard command to create the new folder – first, click once on any of the files or folders in your web site's panel to make it active, then hold down the Ctrl key and press the N key. 
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(this example already has the "output" folder)

You may be prompted to enter a name, so type in "output" and click on the Ok button.

Otherwise, you will see a folder named "New Folder" in your web site's panel – if the name "New Folder" is highlighted, you can type in "output" to change the name, then click on the folder icon next to it, or press the enter key. If "New Folder" is not highlighted, click once on "New Folder" to select it. Then click on the menu button for Rename, or click on "New Folder" with the right mouse button and select Rename from the pop-up menu. Type in "output" to change the name, then click on the folder icon next to it, or press the enter key.

You should see a folder named "output" in the panel.

Do not log out of the FTP session, you need to set permissions for the output folder.

Set permissions for the output folder

Your web site host has security features to protect your files. You decide which files can be modified or replaced by programs like ASB. You need to set permissions (also known as "attributes") for your new output folder that allow ASB to create the article and index files. This is known as full permissions to "read, write, and execute."

Most web hosts have Unix or Linux, and use a three-digit number known as "chmod" to set the permissions of a particular file or folder. A chmod setting of  "777" is required on the output folder for ASB. If your web site host has a Windows server, permissions are usually set by your host admin, so you may not be able to, or need to, set the output permissions yourself.

► For more about permission settings see

http://websiteowner.info/tutorials/server/permissions.asp
Set permissions with your web site File Manager

Log in to your web site Control Panel, and click on the icon for the File Manager. Find the ArticleSiteBuilder folder, and double-click on it to open it.

Find the output folder, and look across its horizontal line of information. If you see a link that looks something like "drwxrwxrwx" (all of the letters might not be there – that's ok),  click on it. You should see a control with checkboxes for Owner, Group, and Others. Check all the boxes by clicking on the blank ones, then click on the Ok or Submit or Set or Change button.

If your File Manager does not have an active link for the permissions, click once on the folder icon next to "output" to select it. On the right side of your File Manager, you should see a panel with information about the output folder. There should be a group of checkboxes for the Access Permissions. Check all the boxes by clicking on the blank ones, then click on the Ok or Submit or Set or Change button.

Whichever method your File Manager uses for setting permissions, you might see a chmod number value near the checkboxes. You can enter "777" instead of checking the boxes, and you should see all the boxes become selected.

Set permissions with FTP

If you're not still connected, connect to your web site FTP server with your FTP program. (The built-in Internet Explorer FTP does not permit you to set permissions.)

In the panel that displays your web site's files and folders, find the output folder. Click on the menu button for Properties (when you position the mouse over the menu icons, you should see tips describing them). You can also click on the output folder with the right mouse button, and select Properties from the pop-up menu.
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If you see a place to enter the chmod number, change it to "777" – otherwise, click on all the empty checkboxes to select them. Then click on the OK,  Set,  Go, or Submit button.

Installation Complete

You have completed the steps necessary to install and configure ASB. Now you can enjoy using it! Please refer to the Using Article Site Builder manual to continue.
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Paste database instructions here!
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